
Cisco Supervisor DesktopUserGuide
CAD10.6 for Cisco Unified Contact Center ExpressRelease 10.6
First Published: First Published: December 17, 2014

Last Updated: Last Updated: April 1, 2015

Cisco Systems, Inc.www.cisco.com



THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO
CHANGE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE
BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUTWARRANTY OF ANY KIND, EXPRESS OR IMPLIED.
USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE
INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS
REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR
CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of
California, Berkeley (UCB) as part of UCB’s public domain version of the UNIX operating system. All rights reserved.
Copyright © 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE
SUPPLIERS ARE PROVIDED “AS IS” WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL
WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING,
USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR
INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA
ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other
countries. To view a list of Cisco trademarks, go to this URL: www.cisco.com/go/trademarks. Third-party trademarks
mentioned are the property of their respective owners. The use of the word partner does not imply a partnership
relationship between Cisco and any other company. (1110R)

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses
and phone numbers. Any examples, command display output, network topology diagrams, and other figures included in
the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative
content is unintentional and coincidental.

Cisco Supervisor Desktop User Guide

© 2014, 2015 Cisco Systems, Inc. All rights reserved.

http://www.cisco.com/go/trademarks


Contents

Introduction 6

Obtaining Documentation and Submitting a ServiceRequest 6

Documentation Feedback 6

Supervisor Desktop Feature Levels 6

Logging In 8

Login Notes 8

Logging in to Cisco Unified Presence 9

Access Through a VPN 9

VPN Tunneling 10

Automated Updates 12

CADDesktop Applications 12

Java RuntimeEnvironment 13

The Supervisor Desktop Window 14

Preferences 17

Restoring the InterfaceDefault Layout 19

Agents Tree 20

Formatting Agent Names in theAgents Tree 20

Accessibility 21

Toolbar and Shortcut Keys 21

Integrated Browser Pane 24

StatusBar 24

Integrated Browser 25

Toolbar Buttons and Shortcut Keys 25

Real Time Displays 27

Agent - Agent vs. Team Summary 28

Agent Contact - ActiveCall 30

Agent Contact - Active E-Mail 31

Agent Contact - EnterpriseCall History 32

Agent Contact - EnterpriseData 32

Agent Logs - Call 32

Agent Logs - State 33



Agents - Team State 33

Agents - Team Summary 34

E-Mail CSQ- Assigned 36

E-Mail CSQ- Detail 37

E-Mail CSQ- Queued 37

E-Mail CSQ- Resolved 38

E-Mail CSQ- Summary 39

E-Mail CSQ- Team Summary 40

VoiceCSQ- Detail 42

VoiceCSQ- Summary 42

VoiceCSQs- Team Summary 44

Agent E-Mail Viewer 47

Supervisor Record Viewer 48

Toolbar and Shortcut Keys 51

Supervisor Work Flow Administrator 52

Setting Up aWork Flow 52

Example of Setting Up a SupervisorWork Flow 54

Work Flow Actions 58

AudibleAlert Action 58

E-Mail Alert Action 59

MessageBox Action 61

Report Action 62

TreeControl Action 63

Supervising Agents 64

Monitoring anAgent 64

Pushing aWeb Page to anAgent 65

Barging in on a Call 66

Intercepting a Call 66

Recording a Call 67

Changing anAgent’sACDState 69

Monitoring Agent-Deleted E-Mail 70

Reviewing Agent E-Mail 70



Sending a TeamMessage 70

Chat 73

Chat Contacts 74

Chat Shortcut Keys 75

Sending a Chat Message 75

Predefined High Priority Chat Messages 76

Calling Someone in theChat List 77

Cisco Unified CCX Web Chat 78

Unified CCXWeb Chat Reports 78

Service Autorecovery 79

PhoneNetwork Failure 79



Introduction
Cisco Supervisor Desktop is a robust computer telephony integration solution for IP-
based contact centers that is easy to deploy, configure, andmanage. It provides
supervisorswith powerful tools to increaseproductivity and improve customer
satisfaction.

Supervisor Desktop’s features allow you to view real time statistics,monitor and coach
agents, barge-in, intercept, and record active agent callswhen necessary, enabling
effectivemanagement of agent resources.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering
additional information, see themonthlyWhat’s New inCisco Product Documentation,
which also lists all new and revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to theWhat’s New inCisco Product Documentation as a Really Simple
Syndication (RSS) feed and set content to bedelivered directly to your desktop using a
reader application. TheRSS feeds are a free service and Cisco currently supports RSS
version 2.0.

Documentation Feedback
You can provide comments about this document by sending e-mail to the following
address:

ccbu_docfeedback@cisco.com

Weappreciate your comments.

Supervisor Desktop Feature Levels
There are three feature levels in Supervisor Desktop: Standard, Enhanced, and Premium.

The following table outlines the features available at each feature level. All features not
listed here are present in both versions.
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Feature Standard Enhanced Premium

Silent monitoring x x

Barge-in x x

Intercept x x

Recording x x

Chat with teammembers (CAD agents only) x x

Teammessages x x

E-mail contact service queues (CSQs) x

Supervisor work flows—threshold alerts for tree control
actions

x x

Supervisor work flows—all actions except threshold
alerts for tree control actions

x

Real time displays (text) x x x

Real time displays (charts) x

Web page push to agents x

Contact service queue statistics x x x

Cisco Unified Personal Communicator x x x

Cisco Unified CCX Web Chat x
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Logging In

Note: If youwant to use all of the functionality of Supervisor Desktop, youmust
first log into Agent Desktop. Formore information, see theCisco Agent Desktop
User Guide.

To log in to Supervisor Desktop:

1. Start Supervisor Desktop. TheSupervisor Login dialog box appears.

2. Enter your Supervisor Desktop login nameor ID and password in the appropriate
fields, and then click OK or press Enter. Supervisor Desktop starts, but does not show
any data, and the status bar displays “No Service”.

3. From theTeam drop-down list, select a team. Supervisor Desktop displays thedata
for the selected team.

4. If your configuration includesCisco Unified Presence, you have chosen to log into
Unified Presence throughSupervisor Desktop (see Logging into Cisco Unified
Presence), and your Unified Presence login is different from your Supervisor Desktop
login, theCisco Unified PresenceServer Login dialog box appears. Type your Unified
Presence usernameand password and click Login.

Note: In a high availability overWAN triangle configuration (both servers and
theCADclient applications communicate over aWAN) when theWAN link
between the two servers is down, Supervisor Desktopmight not function
properly and youmight not be able to see all active agents.

Login Notes
The first time you log into Supervisor Desktop:

n Your user ID and password are the sameas your Agent Desktop user ID and pass-
word.

n TheUser ID field is empty. The next time you log in, theUser ID field is automatically
filled with the information you entered before. If you share a computer with another
supervisor, verify that this field has your information and not the other supervisor’s
information.
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n It might take some time for Supervisor Desktop to start becausedefault report
datamust begenerated.

Logging in to Cisco Unified Presence
You can log into Cisco Unified Presence through any oneof the following applications:

n Agent Desktop

n Supervisor Desktop

n Cisco Unified Personal Communicator

Important: Do not log in to Unified Presence throughmore than one application,
even using different user IDs. Unified Presence cannot communicatewithmore
than one client application on any one computer.

By default, Supervisor Desktop assumes that you log into Unified Presence throughAgent
Desktop. If you choose to log in throughSupervisor Desktop, youmust configure this
option (EnableCisco Unified Presence) through thePreferenceswindow. SeePreferences
formore information.

Information from Unified Presence (for example, non-agent subject matter experts and
personal contacts) appears only in theContact Selectionwindow accessed from the
application throughwhich you logged into Unified Presence.

For example, if you log into Unified Presence throughSupervisor Desktop, theSupervisor
Desktop Contact Selectionwindowwill display Unified Presence information, agents, and
supervisors, and theAgent Desktop Contact Selectionwindowwill display only agents
and supervisors.

If you log in to Unified Presence throughUnified Personal Communicator, neither
Supervisor Desktop nor Agent Desktop will display Unified Presence information, and
Unified Personal Communicator will not display agent and supervisor information.

Access Through a VPN
Supervisor Desktop is able to connect to theCADservers through a virtual private
network (VPN). This allows a supervisor to work remotely and still have thebenefits of the
full functionality of Supervisor Desktop.

Using a VPN is recommended in order to provide amore secure connection.
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When a desktop is using network address translation (NAT) due to a firewall or router, then
VPN softwaremust be used on thedesktop to ensure full bi-directional network
connectivity between the contact center servers and thedesktop. Failure to useVPN
softwarewill result in connectivity issues and a loss in functionality such as silent
monitoring, recording, and incoming chat message and teammessage failures.

Cisco AnyConnect SecureMobility Client is verified to work correctly with Supervisor
Desktop.

VPN solutions from other vendorsmight result in feature loss. Because they have not been
formally verified, they are not supported.

Note: After installing Cisco AnyConnect SecureMobility Client, youmust restart
your computer. If you do not restart,monitoring and recording will not work
properly.

VPNTunneling

There are two types of VPN tunnelingmechanism, full tunneling and split tunneling, both of
which are supported for connection betweenSupervisor Desktop and theCADservices.

VPN Full Tunneling

VPN full tunneling virtually replaces the network connectionwith the local area network
defined by theVPN. If VPN full tunneling is used to connect to CADservers, theVPN
connectionmust be established before starting Supervisor Desktop. If theVPN
connection is lost during a session, youmust closeSupervisor Desktop, reestablish the
VPN connection, and then restart Supervisor Desktop.

VPN Split Tunneling

VPN split tunneling allows you to access a public network and a local area network
simultaneously, using the samephysical network connection.

There are two types of VPN split tunneling scenarios.

n Scenario 1: TheCADservers are on thepublic network and a third-party applic-
ation is used through theVPN. In this scenario, youmust launch and log into
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Supervisor Desktop before establishing theVPN connection. If theVPN connection
is lost during a session, youmust restart Supervisor Desktop and then reestablish
theVPN connection.

n Scenario 2: TheCADservers are on theVPN and a third-party application is used
through thepublic network. In this scenario, youmust establish theVPN con-
nection before launching Supervisor Desktop. If theVPN Connection is lost during
a session, youmust closeSupervisor Desktop, reestablish theVPN connection,
and then restart Supervisor Desktop.

If Supervisor Desktop can log into all services except theChat service, it must be restarted
after theChat service comesback online.
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Automated Updates
CADenables your administrator to update all instances of theCAD desktop applications
automatically to a newer version. It also ensures that the correct version of Java Runtime
Environment (JRE) is installed on your computer.

CAD Desktop Applications
Every time you launch Supervisor Desktop, the software checks to see if there is an
updated version available, or if therewas a system configuration change that requires a
Windows registry change. If either of these conditions exists, the software automatically
runs the update process.

When an update is available, youwill see a dialog box notifying you that your copy of
Supervisor Desktop will be updated. Click OK to proceedwith the update.

A progress bar is displayed to show you the status of the update process.

When the update is finished, youwill see a final dialog box that tells you that the update is
complete, and which applicationswere updated. If you haveCisco Agent Desktop and
Cisco Desktop Administrator on your PC, they will also havebeen updated.

Note: BecauseAgent Desktop is automatically installed whenSupervisor
Desktop is installed, only Supervisor Desktop will be listed as having been
updated in the final dialog box. Agent Desktop will be listed only if Supervisor
Desktop is not present on your PC.

When you click OK to close thedialog box, any CADdesktop application running on your
desktop restarts automatically.

Note: To ensure that automated updates function correctly, youmust configure
Internet Explorer so that it checks for newer versions of stored pages. To
configure this setting, launch Internet Explorer and chooseTools > Internet
Options. In theBrowsing history section on theGeneral tab, click Settings. Select
the option labeled Every time I visit theweb page.

Note: If your system is configured with two Unified CCX servers, and one server is
upgradedwhile your instanceof Supervisor Desktop is connected to the older

12



Automated Updates

Unified CCX server, and your administrator performs a failover to switch all
agents to the upgraded server, your instanceof Supervisor Desktop will not
automatically upgradewhen you log into the new server. Youmust shut down
Supervisor Desktop and start it again for the automatic upgrade to takeplace.

Java Runtime Environment
Every timeSupervisor Desktop is launched, it checks to see if the correct version of Java
RuntimeEnvironment (JRE) is installed. If the correct version is not detected, youwill be
notified, and Supervisor Desktop will download and install the correct JRE.
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The Supervisor Desktop Window
TheSupervisor Desktop window is divided into five areas:

n TheSkill Groups tree,which lists all of theCSQsassociated with the team you
choose from the team selection list

n The agents tree,which lists all of the agents and supervisors on the team

n Tabular/graphical real timedisplays of CSQ information

n Tabular/graphical real timedisplays of agent and team information

n Integrated browser (if enabled)

TheSupervisor Desktop interface is highly configurable. By default, the browser is not
enabled and thepanes are not dockable. However, you can add or remove real time
displays, enable the integrated browser, and enable all panes to act as dockablewindows
(so you canmove them and resize them independently). You can also change the size of
the toolbar icons from thedefault 16 × 16 pixels to 32 × 32 pixels.

The specific panes that are displayed dependson the nodes that you select in theSkill
Groups and Agents tree. If you choose to enable the integrated browser, the real time
displays and thebrowser appear on tabs in the right pane.

The figure below shows theSupervisor Desktop window in its default configuration.
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Real timedisplay panes are identified as containing information related to voiceCSQs, e-
mail CSQs, or agents by the text in their title bars, as shown in the following figure.

WhenSupervisor Desktop is in default layout (movablewindowsare disabled), CSQ real
timedisplays occupy approximately the top half of the right pane, and theAgents real time
displays occupy approximately the lower half of the right pane. The treepanes and real
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timedisplay panes can all be resized by dragging the horizontal splitters up and down and
the vertical splitters left and right.

If you choose to enablemovablewindows (seePreferences), all of the real timedisplay
panes can be resized andmoved anywhere on your desktop. However, each typeof
display can only dock to another display of its own type. In other words, CSQdisplays
dock to other CSQdisplays and Agent displays dock to other Agent displays. For
example, you cannot separate oneAgent display from another Agent display, although
they can be resized in relationship to each other, as shown in the following figure.

You can also drag the vertical splitter between the trees panes and thedisplay panes left or
right, and the horizontal splitter between the two trees panes up and down.

If you choose to enable the integrated browser, the real timedisplays and thebrowser
appear on tabs in the area to the right of theSkill Groups and Agents navigation trees.
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Preferences
ThePreferencesdialog box controlswhat information is displayed in thedisplay panes
and how thosepanesbehave. The following table summarizeswhat you can configure
using Preferences.

Tree Control Node Available Displays Configure
Columns?

Configure
Graphs?

Configure
Refresh?

CSQs Team Summary Yes Yes Yes

Voice > CSQ Summary Yes No Yes

Detail Yes Yes No

E-Mail > CSQ
(Premium pack-
age only)

Summary Yes No Yes

Detail Yes No Yes

Assigned Yes No Yes

Queued Yes No Yes

Resolved Yes No Yes

Team Team Summary Yes Yes Yes

Team State Yes Yes No

Agent Agent vs. Team Summary Yes Yes Yes

Logs State Yes No No

Call Yes No No

Calls Active Call Yes No No

Enterprise Data Yes No No

Enterprise Call History Yes No No

E-Mail Active E-Mail Yes No No

Browser Supervisor browser tabs — — —

To set your preferences:
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1. ChooseView > Preferences. ThePreferenceswindow appears.

2. In the left pane, select a node. The right panedisplays that node’s settings for each
available real timedisplay.

n Click Configure…next to Columns and select the columns to appear in the real
timedisplay. Use the up and down arrows to set the order inwhich they should
appear.

n Click Configure…next to Graphical Displays and select the typeof chart you
want to display. You can select only one typeof chart for each real timedisplay.

n Click Refresh rate in seconds and adjust the real timedisplay’s refresh rate. The
refresh rate ranges from every 5 to 60 seconds,with thedefault set to 15
seconds. For CSQs, you can configure thedata refresh to bedonemanually by
setting the refresh rate to zero (0).

3. In the left pane, select theBrowser node. The right panedisplays browser settings.
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n In theBrowser HomePage field, enter theURL for your homepage. Thedefault
iswww.cisco.com.

n In theNumber of Browser Tabs field, select the number of browser tabs you
want, from 1 to 10. You can specify what web pageappears in the tab by
selecting the tab from theBrowser Tab field and entering theURL of the
desired web page. If you do not set a URL the tab will display thedefault, www.-
cisco.com.

4. At the bottom of thePreferenceswindow are options that allow you to customize
Supervisor Desktop. Select or clear the check box for each option to turn it on or off.
Theoptions are:

n Enablemovablewindows—lets you rearrange the real timedisplay panes.

n Enable Integrated Browser—gives you access to the integrated browser.

n ChangeReport Font Size to <size>—sets the font size in real timedisplays from
15 to 72 points.

n Enable LargeToolbar Icons—changes the size of toolbar icons from 16 × 16
pixels to 32 × 32 pixels.

n EnableCisco Unified Presence—gives you access to Unified Presence users in
theChat window. Youmust restart Supervisor Desktop (and Agent Desktop, if
running) for this option to take effect.

n EnableCiscoWeb Chat—gives you access to Cisco Unified Contact Center
ExpressWeb Chat through the integrated browser. Unified CCXWeb Chat will
appear in the first tab after the real timedisplays.

5. When you are finished configuring Supervisor Desktop, click OK.

Restoring the InterfaceDefault Layout

To restoreSupervisor Desktop to its default layout, open thePreferenceswindow (choose
View > Preferences) and click RestoreDefault Layout.

Clicking this buttonmakes the following changes:

n In theReal TimeDisplays pane,movesdisplays to their default positions

n Disables the integrated browser

n Disablesmovablewindows

n Disables any graphical real timedisplays you selected previously
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n Resets the toolbar buttons to thedefault size

n DisablesCisco Unified Presence

n DisablesCiscoWeb Chat

Clicking this button does not make any of the following changes:

n Columns are not resized to thedefault widths

n Real timedisplay columns that you delected previously are not restored

n Report font size is not changed back to thedefault (15 points)

Youmust manually resize the columns yourself and reset the other two elements to their
default settings in thePreferenceswindow.

Agents Tree
TheAgents treedisplays all agents and supervisors on the selected teamwho are currently
logged in, and any calls (ACDand non-ACD) they are on.

n The icon next to the agent’s name indicates the agent’s current agent state.

n This icon indicates that an agent is in theNot Ready state and is on a call.

n If an agent device ismulti-line–enabled, an asterisk next to an inbound or outbound
call indicates that the call is on anACD line.

Note: If you have theStandard feature level, only IP Phone agents appear in the
Agents tree.

Note: If an agent’s team assignment is changed, the changedoes not go into
effect until theCADdesktop applications are restarted.

Formatting Agent Names in theAgents Tree

ThePreferencesdialog box enables you to control how agent names are displayed in the
Agents tree.

An agent can be identified by any or all of the following:

n Name

n Extension
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n Application used by the agent (CADor Cisco IP PhoneAgent [IPPA])

At least oneof thesemust be selected to identify an agent in theAgents tree. If all options
are selected, the information in the agents tree appears as follows:

JaneSmith x1500 CAD

In this example, JaneSmith is a CADagent on extension 1500.

To format agent names in theAgents tree:

1. ChooseView > Preferences and then select theAgents node.

2. In the Format node text grid, check the elements youwant to use to identify an agent.
Youmust select at least one element. A sample of what the namewill look like appears
on theSample line.

3. Click OK.

Accessibility
Supervisor Desktop has a number of features that improve accessibility for vision-
impaired users.

n UsesWindows settings for screen resolution, color/contrast, and font settings

Note: Enable high contrast before launching Supervisor Desktop to ensure
that all tablesmatch the high contrast settings.

n Scrolling or non-scrolling teammessages

n Shortcut keys and tool tips that are compatiblewith screen readers

n Toolbar buttons available in small (16 × 16) and large (32 × 32) sizes

n Navigation through each pane, browser, and all the elements of themainwindow
using theTab key

n Support for Job AccessWith Speech (JAWS) 11 screen reader software

Toolbar and Shortcut Keys
The following tables list the toolbar buttons and shortcut keys that you can use in
Supervisor Desktop.
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Button Name Shortcut Description

Logout Ctrl+L Logs the selected agent out of the
ACD.

Ready Ctrl+E Changes the seected agent’s state to
Ready.

Not Ready Ctrl+N Changes the selected agent’s state to
Not Ready.

Work Ctrl+D Changes the selected agent’s state to
Work.

Agent State Buttons

Button Name Shortcut Description

Barge In Ctrl+B Enables you to join an agent’s phone
conversation.

Intercept Ctrl+I Enables you to intercept a call while
disconnecting the agent from the call.

Call Handling Buttons

Button Name Shortcut Description

Chat Ctrl+J Opens the Chat Selection window.

TeamMessage Ctrl+X Opens the TeamMessage window.

Refresh Ctrl+F Refreshes the information in the Skill
Groups tree and the TeamAgent State
Display data view pane that has
changed since the last sync.

— Coach by Push-
ing a Page

Ctrl+U Opens the Push URL to Agent window.

Team Communication Buttons
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Button Name Shortcut Description

Start Record Ctrl+R (Enhanced/Premium only) Starts
recording the selected call.

Stop Record Ctrl+S (Enhanced/Premium only) Stops
recording the selected call.

Recording Buttons

Button Name Shortcut Description

Start Voice Mon-
itor

Ctrl+A Starts monitoring the selected agent.

Stop Voice Mon-
itor

Ctrl+P Stops monitoring the selected agent.

Voice Monitor
Volume

Ctrl+V Opens a volume slider control.

Voice Monitoring Buttons

Shortcut Keys Description

Ctrl+Shift+S Selects the Skill Groups node in the Skill Groups tree.

Ctrl+Shift+A Selects the Agents node in the Agents tree.

Ctrl+Shift+B Shifts focus to the browser pane.

Ctrl+Shift+R Shifts focus to the real time displays.

Ctrl+Shift+T Selects the Team node in the Agents tree.

Ctrl+H Selects the Team Selection drop-down list.

Ctrl+T Shifts focus to what was previously selected in the Agents tree.

Ctrl+Shift+H Opens the Service Status window.

Accessibility Shortcut Keys

Once you have set focus to theSkill Groups tree, theAgents tree, or the team node in the
agents tree, you can use the tab key to navigate to the real timedisplay panes.Once your
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focus is in a real timedisplay pane, you can use the arrow keys to navigate around the
display grid.

Note: The tab key willmove you among the real timedisplay panes, but the order
inwhich you access themwill not necessarily be in syncwith thephysical
arrangement of the display panes on your desktop.

Integrated Browser Pane
The integrated browser pane allows you to view internet and intranet web pages to help
you assist agents and customers. The integrated browser has from 1 to 10 tabs, each of
which can display a different web page. You can configure each tab to display a specific
website.

Formore information about this pane, see Integrated Browser.

Status Bar
The status bar displays current information about Supervisor Desktop.

From left to right, the status bar displays the following information:

n User name

n User ID or name

n Current status of Supervisor Desktop features

n Current system time in 24-hour format

In the event of a service failure, theCurrent Status section changes from “In Service” to
“Partial Service” or “No Service.” To learnwhich features are affected by the service
outage, double-click theCurrent Status section of the status bar to view a popupwindow
that displays active or inactive features.
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Integrated Browser
The integrated browser enables you to view intranet and internet web pages fromwithin
Supervisor Desktop.When enabled, the browser appears as oneormore tabs in the real
timedisplay pane,with up to 20 characters of the nameof the current web pagedisplayed
on the tab. The real timedisplays appear on another tab in that pane (the default position is
in the first tab). The integrated browser can display up to 10 tabs, each containing a
different web page. TheAddress drop-down list contains theURLsof the last 25 websites
visited for quick access to frequently visited websites.

Note: Youmust have Internet Explorer installed on your PC for the integrated
browser to function.

Note: The integrated browser supports only oneweb session at a time for web
applications that use cookies for sessionmanagement. For example, you cannot
log into aweb application that uses cookies in one tab asUser A and then log into
the sameweb application in another tab asUser B. However,multipleweb
sessions are supported for web applications that useURL-based session
management.

Note: Reordering of integrated browser tabs by dragging is not supported.

By default, the browser is not enabled. SeePreferences for instructions on enabling the
browser and configuring a homepage.

Toolbar Buttons and Shortcut Keys
The integrated browser toolbar contains basic browser buttons that allow you to navigate
among theweb pages you view, refresh a current page, and return to your homepage.

The integrated browser toolbar buttons and shortcut keys are listed in the following table.

Button Name Shortcut Description

Back Alt+left arrow Returns you to the last page you
viewed.
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Button Name Shortcut Description

Forward Alt+right arrow Takes you to the page you viewed
before clicking the Back button.

Stop Esc Stops the browser from loading a web
page.

Refresh F5 Refreshes the current web page.

Home Alt+Home Returns you to your predefined home
page.

— Address Alt+D Selects the Address field
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Real Time Displays
The real timedisplays contain the information you need to manage your teamsand
agents. Real timedisplays include the following:

n Agent – Agent vs. Team Summary

n Agent Contact – ActiveCall

n Agent Contact – Active E-Mail

n Agent Contact – EnterpriseCall History

n Agent Contact – EnterpriseData

n Agent Logs – Call

n Agent Logs – State

n Agents – Team State

n Agents – Team Summary

n E-Mail CSQ – Assigned

n E-Mail CSQ – Detail

n E-Mail CSQ – Queued

n E-Mail CSQ – Resolved

n E-Mail CSQ – Summary

n E-Mail CSQ – Team Summary

n VoiceCSQ – Detail

n VoiceCSQ – Summary

n VoiceCSQs – Team Summary

There are two types of displays: tabular and graphical.

n Tabular displays present skill group, team, and agent information in a grid. Tabular
information can be sorted in scending/descending order by clicking any column
header in thegrid. You can sort by one columnonly.

n Graphical displays present the same information as bar charts, except for the
Agent vs. Team Statistics,which is presented as two pie charts.

27



Real TimeDisplays

Note: Graphical displays are available at thePremium feature level only.

Agent - Agent vs. Team Summary
TheAgent vs. Team Summary display is availablewhen you select a specific agent in the
Agents tree. This display presents theperformancedetails for the agent and compares
them to theperformancedetails of the team.

Thedata is obtained from theCADRecording & Statistics service, and is for the current
day starting at midnight. Thedata refresh rate is configurable and ranges from every 5 to
630 seconds. By default it is every 15 seconds.

Thegraphical display is presented as two pie charts. Thesepie charts show the
percentageof time a specific agent spends in variousACDstates in comparison to the
percentages spent by the team as awhole.

.

Note: Percentages in thepie chart are rounded to two decimal places. As a result,
the total of all percentagesmight not equal 100%.

Note: If Other Time is a small value, it might not show up as a slice in thegraphical
display pie chart.

Thedisplay fields are described in the following table.
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Field Description

ID Identifies the statistics as for the selected agent or the team.

Logon Time The amount of time (in seconds) since midnight the agent and team
havebeen logged into Agent Desktop.

Calls Presented The number of inbound calls (ACD and non-ACD) presented to the
agent since midnight.

Calls Handled The number of inbound calls (ACD and non-ACD) presented to and
handled by the agent since midnight.

Max Talking The longest talk time (in seconds) of all calls handled since midnight.

Avg Talking The average talk time and hold time (in seconds) of all calls handled
since midnight.

Total Talking The total Reserved time, talk time, and hold time (in seconds) of all
calls handled since midnight.

Max Ready The longest time (in seconds) spent in the Ready state since midnight.

Avg Ready The average time (in secondsd) spent in the Ready state since mid-
night.

Total Ready The total time (in secondsd) spent in the Ready state since midnight.

Max Not Ready The longest time (in seconds) spent in the Not Ready state since mid-
night.

Avg Not Ready The average time (in seconds) spent in the Not Ready state since mid-
night.

Total Not Ready The total time (in seconds) spent in the Not Ready state since mid-
night.

Max After Call Work The longest time (in seconds) spent in the Work state since midnight.

Avg After Call Work The average time (in seconds) spent in the Work state since midnight.

Total After Call Work The total time (in seconds) spent in the Work state since midnight.

Other Time The total time (in seconds) spent in states other than Talking, Ready,
Not Ready, Reserved, andWork since midnight.

E-Mails Retrieved The number of e-mails received since midnight.

E-Mails Sent The number of e-mails sent since midnight.
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Field Description

Max Processing For all sent e-mail, the longest time (in seconds) spent in the E-Mail
Processing state with the e-mail in focus since midnight. All pro-
cessing time is included, whether it occurred before or after midnight.

Avg Processing For all sent e-mail, the average time (in seconds) spent in the E-Mail
processing state with the e-mail in focus since midnight. All pro-
cessing time is included.

Total Processing For all sent e-mail, the total time (in seconds) spent in the E-Mail Pro-
cessing state with the e-mail in focus since midnight. All processing
time is included, whether it occurred before or after midnight.

Max On Desk For all sent e-mail, the maximum time (in seconds) an e-mail spent on
desk since midnight. On-desk time begins when an agent receives an
e-mail and ends when the agent sends a reply to that e-mail. All on-
desk time is included, whether it occurred before or after midnight.

Avg On Desk For all sent e-mail, the average time (in seconds) an e-mail spent on
desk since midnight. On-desk time begins when an agent receives an
e-mail and ends when the agent sends a reply to that e-mail. All on-
desk time is included, whether it occurred before or after midnight.

Max E-Mail Ready The longest time (in seconds) spent in the E-Mail Ready state since
midnight.

Avg E-Mail Ready The average time (in seconds) spent in the E-Mail Ready state since
midnight.

Total E-Mail Ready The total time (in seconds) spent in the E-Mail Ready state since mid-
night.

Max E-Mail Not Ready The longest time (in seconds) spent in the E-Mail Not Ready state
since midnight.

Avg E-Mail Not Ready The average time (in seconds) spent in the E-Mail Not Ready state
since midnight.

Total E-Mail Not Ready The total time (in seconds) spent in the E-Mail Not Ready state since
midnight.

Agent Contact - Active Call
TheActiveCall display is availablewhen you select an active call under a specific agent’s
name in theAgents tree. This display presents information about each party in the current
active call. Thedata refresh rate is 1 second, and is not configurable.

Thedisplay fields are described in the following table.
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Field Description

Name Name of the parties in the call, if known. If this data is not known,
<unavailable> is displayed.

Number The party’s phone number.

Call Status The party’s hook state (Active or Held).

Duration The length of time the party has been on the call.

Contact Service Queue The ID of the CSQ that the call was queued to, if applicable.

Agent Contact - Active E-Mail
TheActive E-Mail display is availablewhen you select the E-Mail node underneath a
specific agent’s name in theAgents tree.

You can view an e-mail along with any inbound and outbound attachments in Agent E-
Mail Viewer by double clicking the email from any of theReal TimeDisplays.

This display presents a summary of the e-mails the agent isworking on. Thedata is for the
current day starting at midnight. Thedata refresh rate is 1 second, and is not configurable.

Thedisplay fields are described in the following table.

Field Description

From The sender of the e-mail.

To The recipient of the e-mail.

Subject The subject of the e-mail.

Date Received The date the e-mail was received.

Date Retrieved The date the e-mail was retrieved from the queue by the agent.

In Process Duration The length of time the agent spent processing the e-mail. Processing
time includes all time that the agent was in E-Mail Processing state
with the e-mail in focus.

On Desk Duration The length of time the e-mail was on the agent’s desk. On-desk time
begins when an agent receives an e-mail and ends when the agent
sends a reply to that e-mail.

Contact Service Queues The name of the CSQ to which the e=mail was routed.
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Agent Contact - Enterprise Call History
TheEnterpriseCall History display is availablewhen you select an active call under a
specific agent’s name in theAgents tree. This display presents a history of the call’s
presence in the contact center. Thedata refresh rate is 1 second, and is not configurable.

Thedisplay fields are described in the following table.

Field Description

Threshold The acceptable amount of time a call can remain at a particular device
or contact center. The administrator might assign caution and warning
threshold values to each device type, as well as a total threshold value
for a call. If a call remains at a device longer than the defined caution
and warning thresholds, a caution or warning icon is displayed in this
field.

Device A device that the call has passed through.

type The type of device that the call has passed through.

Description Description of the device.

Duration The amount of time that the call spent at the device.

Agent Contact - Enterprise Data
TheEnterpriseData display is availablewhen you select an active call under a specific
agent’s name in theAgents tree. Thedata displayed is configured by your administrator.
Thedata in the report can be refreshedmanually by clicking theRefresh button on the
toolbar.

Agent Logs - Call
TheAgent Call Log display is availablewhen you select the Logs nodeunderneath a
specific agent’s name in theAgents tree.

This display presents a history of the callsmadeand received by the agent during the
current session. By default, the data displayed is sorted in ascending order by timeof day.
Thedata in the report can be refreshedmanually by clicking theRefresh button on the
toolbar.

Thedisplay fields are described in the following table.
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Field Description

Start Time The time the call was answered.

Direction Indicates if this is an inbound or outbound call.

Answered (Yes/No) Indicates if this is an answered or unanswered call.

Calling Party The originating phone number.

Called Party The recipient phone number.

Call Duration The length of the call.

Agent Logs - State
TheAgent State Log display is availablewhen you select the Logs nodeunderneath a
specific agent’s name in theAgents tree.

This display presents a history of theACDstates the agent transitioned through during the
current session. By default, the data displayed is sorted in ascending order by timeof day.
Thedata in the report can be refreshedmanually by clicking theRefresh button on the
toolbar.

Thedisplay fields are described in the following table.

Field Description

Start Time The time the agent state was initiated.

Agent State The ACD agent state.

Wrap-up Data Any wrap-up data the agent entered, if the agent state transitioned to
after ending a call or sending an e-mail is Work (after-call work).

Reason Code Any reason code the agent entered, if the agent state transitioned to is
Not Ready or Logout (if required).

State Duration The length of time the agent was in the agent state.

Agents - Team State
TheTeam State display is availablewhen you select the Team nodeor Agents node in the
Agents tree. This display presents the current agent state status for each agent on the
team. By default, the data displayed is sorted in ascending order by agent name.
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Note: If the agent is assigned to a new teamwhile logged in, that agent will still
show up as amember of the old team in theTeam State display until the agent
logs out and logs in again. After logging in, the agent will show up as amember of
the new team in theTeam State display.

Thedata is obtained from theChat service. Thedata refresh rate is 1 second, and is not
configurable.

Thegraphical display of the information consists of a bar chart with ACDstates on theY
axis and the number of agents currently in eachACDstate.

Thedisplay fields are described in the following table.

Field Description

Agent Name The agent’s name.

Agent ID The agent’s ID.

Current State The agent’s current ACD state.

Skill Group The skill group ID of the call the agent is currently servicing (in Talking
state). If there is no call, or if the call is a non-ACD call, this field is
blank.

Contact Service Queue The name of the CSQ.

State Duration The amount of time (in seconds) that the agent has been in the current
agent state.

Reason Code The reason why the agent is in the current ACD state. Reason codes
are available for the Not Ready and Logout states only.

Agents - Team Summary
TheTeam Summary display is availablewhen you select the Team nodeor Agents node in
theAgents tree.

This display presents the real time state of the agents on the selected teamwho are
currently logged into theACD. By default, the data displayed is sorted in ascending order
by agent name.
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Note: If the agent is assigned to a new teamwhile logged in, that agent will still
show up as amember of the old team in theTeam Summary display until the
agent logs out and logs in again. After logging in, the agent will show up as a
member of the new team in theTeam Summary display.

Thedata is obtained from theCADRecording & Statistics service, and is for the current
day starting at midnight. Thedata refresh rate is configurable and ranges from every 5 to
60 seconds. By default it is every 15 seconds.

Graphical displays of the information consist of bar chartswith agent nameson theY axis
and the average amount of time (hh:mm:ss) the agent spent in a selected ACDstate.

Thedisplay fields are described in the following table.

Field Description

Agent Name The agent’s name.

Agent ID The agent’s ID.

Logon Time The total amount of time the agent has been logged in to the
ACD today.

Calls Presented The number of inbound calls (ACD and non-ACD) presented to the
agent today.

CAlls Handled The number of inbound calls (ACD and non-ACD) presented to and
answered by the agent today.

Max Talking The longest talk time of all calls handled today.

Avg Talking The average talk time and hold time of all calls handled today.

Total Talking The total resrved time, talk time, and hold time of all calls handled
today.

Max Ready The longest time the agent spent in the Ready state today.

Avg Ready The average time the agent spent in the Ready state today.

Total Ready The total time the agent spent in the Ready state today.

Max Not Ready The longest time the agent spent in the Not Ready state today.

Avg Not Ready The average time the agent spent in the Not Ready state today.
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Field Description

Total Not Ready The total time the agent spent in the Not Ready state today.

Max After Call Work The longest time spent in the Work state today.

Avg After Call Work The average time the agent spent in the Work state today.

Total After Call Work The total time the agent spent in the Work state today.

Other Time The total time (in seconds) the agent spent in states other than Talking,
Ready, Not Ready, Reserved, andWork since midnight.

E-Mail CSQ - Assigned
TheAssigned display is availablewhen you select a specific CSQ from theContact
ServiceQueues> E-Mail tree.

Double-click any e-mail listed in thedisplay to view the e-mail in theAgent E-Mail Viewer.

Thedata is for the last seven days. Thedata refresh rate is configurable and ranges from
every 5 to 60 seconds. By default it is every 15 seconds.

There is no graphical display available for these statistics.

Thedisplay fields are described in the following table.

Field Description

Agent Name The agent’s name.

From The sender of the e-mail.

To The recipient of the e-mail.

Subject The subject of the e-mail.

Date Received The date the e-mail was received.

Date Queued The date the e-mail was moved to the CSQ.

Date Retrieved The date the e-mail was retrieved from the queue by the agent.

E-Mail State The agent’s current e-mail state.

Process Duration The length of time the agent spent processing the e-mail. Processing
time includes all time that the agent was in E-Mail Processing state
with the e-mail in focus.

Draft Duration The length of time the e-mail is in Draft state since the agent retrieved
it from the CSQ.
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E-Mail CSQ - Detail
TheDetail display is availablewhen you select a specific CSQ from theContact Service
Queues> E-Mail tree.

Double-click any e-mail listed in thedisplay to view the e-mail in theAgent E-Mail Viewer.

Thedata is for the current day starting at midnight. Thedata refresh rate is configurable
and ranges from every 5 to 60 seconds. By default it is every 15 seconds.

There is no graphical display available for these statistics.

Thedisplay fields are described in the following table.

Field Description

Agent Name The agent’s name.

Current Voice State The agent’s current call ACD agent state.

Voice State Duration The length of time the agent has been in the current call ACD agent
state.

Voice Reason Code The reason code the agent selected when transitioning to the current
call ACD agent state.

Current E-Mail State The agent’s current e-mail state.

E-Mail State Duration The length of time the agent has been in the current e-mail state.

E-Mail Reason Code The reason code the agent selected when transitioning to the current
e-mail state.

Contact Service Queue The name of the CSQ for which the agent is currently handling a con-
tact, if any.

Contact Service Queue ID The ID of the CSQ for which the agent is handling a contact, if any.

Media The media type of the CSQ, Voice or E-Mail.

E-Mail CSQ - Queued
TheQueued display is availablewhen you select a specific CSQ from theContact Service
Queues> E-Mail tree.

Double-click any e-mail listed in thedisplay to view the e-mail in theAgent E-Mail Viewer.

Thedata is for the last seven days. Thedata refresh rate is configurable and ranges from
every 5 to 60 seconds. By default it is every 15 seconds.

37



Real TimeDisplays

There is no graphical display available for these statistics.

Thedisplay fields are described in the following table.

Field Description

From The sender of the e-mail.

To The recipient of the e-mail.

Subject The subject of the e-mail.

Date Received The date the e-mail was received.

Date Queued The date the e-mail was moved to the CSQ.

E-Mail CSQ - Resolved
TheResolved display is availablewhen you select a specific CSQ from theContact
ServiceQueues> E-Mail tree.

Double-click any e-mail listed in thedisplay to view the e-mail in theAgent E-Mail Viewer.

Thedata is for the last seven days. Thedata refresh rate is configurable and ranges from
every 5 to 60 seconds. By default it is every 15 seconds.

There is no graphical display available for these statistics.

Thedisplay fields are described in the following table.

Field Description

Agent Name The agent’s name.

From The sender of the e-mail.

To The recipient of the e-mail.

Subject The subject of the e-mail.

Date Received The date the e-mail was received.

Date Completed The date the e-mail was sent to the customer or to the Peer Review
Queue.

E-Mail State The agent’s current e-mail state.

Wrap-up Data Any wrap-up data the agent entered, if the agent state transitioned to
after ending a call or sending an e-mail is Work (after-call work).
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Field Description

Process Duration The length of time the agent spent processing the e-mail. Processing
time includes all time that the agent was in E-Mail Processing state
with the e-mail in focus.

Draft Duration The length of time the e-mail is in Draft state since the agent retrieved
it from the CSQ.

Date Reviewed The date the e-mail is sent to the peer review agent.

Review Process Duration The time the peer review agent spent on the e-mail after retrieving it
from the queue.

Review Draft Duration The time the e-mail was in Draft state since it was retrieved from the
CSQ by the peer review agent.

E-Mail CSQ - Summary
TheSummary display is availablewhen you select a specific CSQ from theContact
ServiceQueues> E-Mail tree.

You can view an e-mail along with any inbound and outbound attachments in Agent E-
Mail Viewer by double clicking the email from any of theReal TimeDisplays.

Thedata is for the current day starting at midnight. Thedata refresh rate is configurable
and ranges from every 5 to 60 seconds. By default it is every 15 seconds.

There is no graphical display available for these statistics.

Thedisplay fields are described in the following table.

Field Description

Contact Service Queue Name of the CSQ.

Agents Logged In The number of agents in this CSQ who are currently logged in.

Agents Processing The number of agents in this CSQ who are currently in the Processing
E-Mail state.

Agents Ready The number of agents in this CSQ who are currently in the Ready state.

Agents Not Ready The number of agents in this CSQ who are currently in the Not Ready
state.
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Field Description

Oldest E-Mail in Queue Of the e-mails currently in queue for this CSQ, the length of time in
queue (in seconds) of the e-mail that has been in the queue the
longest.

Total E-Mail in Queue The current number of e-mails in queue that have not been routed to
an agent.

Total E-Mails Received The number of e-mails routed to this CSQ since the Start Time.

Handled Today The number of e-mails routed through this CSQ that agent have sent
since midnight. The time of the sent event determines whether the e-
mail is included in the count.

Average Handle The average processing time for e-mails sent since midnight. All the
processing time is included for the e-mail, including any time before or
after midnight.

Average Response The average response time for e-mails sent since midnight. Response
time is the difference between the times the e-mail was received and
sent. All the response time is included for the e-mail, including any
time before or after midnight.

Longest Handle Of the e-mails routed through the CSQ and sent since midnight, the
handle time (in seconds) for the e-mail with the longest handle time.
All the processing time is included for the e-mail, including any time
before or after midnight.

Longest Response Of the e-mails routed through the CSQ and sent since midnight, the
response time for the e-mail with the longest response time (in
seconds). All the response time is included for the e-mail, including
any time before or after midnight.

E-Mail CSQ - Team Summary
TheTeam Summary display is availablewhen you select theContact ServiceQueues> E-
Mail node.

Note: If the agent is assigned to a new teamwhile logged in, that agent will still
show up as amember of the old team in the E-mail CSQs – Team Summary
display until the agent logs out and logs in again. After logging in, the agent will
show up as amember of the new team in the E-mail CSQs – Team Summary
display.

You can view an e-mail along with any inbound and outbound attachments in Agent E-
Mail Viewer by double clicking the email from any of theReal TimeDisplays.
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Thedata is for the current day starting at midnight. Thedata refresh rate is configurable
and ranges from every 5 to 60 seconds. By default it is every 15 seconds.

There is no graphical display available for these statistics.

Thedisplay fields are described in the following table.

Field Description

Contact Service Queue The name of the CSQ.

Agents Logged In The number of agents currently logged in who support the CSQ.

Agents Processing The number of agents currently in the Processing E-Mail state who sup-
port the CSQ.

Agents Ready The number of agents currently in the E-Mail Ready state who support
the CSQ.

Agents Not Ready The number of agents currently in the E-Mail Not Ready state who sup-
port the CSQ.

Oldest E-Mail in Queue Of the e-mails currently in queue for this CSQ, the length of time in
queue (in seconds) of the e-mail that has been in the queue the
longest.

Total E-Mail in Queue The current number of e-mails in queue that have not been routed to
an agent.

Total E-Mails Received The number of e-mails routed to the CSQ since midnight.

Handled Today The number of e-mails routed through the CSQ that agents sent since
midnight. The time the e-mail was sent determines whether the e-mail
is included in this count.

Average Handle The average e-mail processing time for e-mails sent since midnight. All
the processing time is included for the e-mail, including any time
before or after midnight

Average Response The average response time for e-mails sent since midnight. Response
time is the difference between the times the e-mail was received and
sent. All the response time is included for the e-mail, including any
time before or after midnight.

Longest Handle Of the e-mails routed through the CSQ and sent since midnight, the
handle time (in seconds) for the e-mail with the longest handle time.
All the processing time is included for the e-mail, including any time
before or after midnight.
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Field Description

Longest Response Of the e-mails routed through the CSQ and sent since midnight, the
response time for the e-mail with the longest response time (in
seconds). All the response time is included for the e-mail, including
any time before or after midnight.

Voice CSQ - Detail
TheVoiceCSQ—Detail display is availablewhen you select a specific CSQ from theSkill
Groups tree.

This display presents information about each agent logged into theACDand assigned to
the selected CSQ. By default, the data displayed is sorted in ascending order by agent
name.

Thedata is obtained from theCADChat service, and are for the current day starting at
midnight. Thedata refresh rate is 1 second, and is not configurable.

Thegraphical display of this information consists of a bar chart with theACDstates on the
Y axis and the number of agents on theX axis.

Thedisplay fields are described in the following table.

Field Description

Agent Name The agent’s name.

Agent ID The agent’s ID.

Current State The agent’s current ACD state.

Skill Group The skill group ID of the ACD call the agent is currently servicing (in
Talking state). If there is no call, or if the call is a non-ACD call, this
field is blank.

Contact Service Queue The name of the CSQ.

State Duration The amount of time (in seconds) that the agent has been in the current
ACD state.

Reason Code The reason why the agent is in the current ACD state. Reason codes
are available for the Not Ready and Logout states only.

Voice CSQ - Summary
TheCSQ— Summary display is availablewhen you select a specific CSQ from theSkill
Groups tree.
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This display presents a summary of a specific CSQ’s statistics. These statistics are from
the entire contact center, not just frommembers of the selected team.

Thedata is obtained from theCTI server unless otherwise noted, and are for the current
day starting at midnight. Thedata refresh rate is configurable and ranges from every 5 to
60 seconds. By default it is every 15 seconds.

Note: Even though you can configure the refresh rate, it is still dependent on how
often the Enterprise service queries theCTI service (every 10 seconds). If the
refresh rate is changed to a shorter time interval, the display will be refreshed at
that interval, but the statisticsmight not changeuntil the Enterprise service
receives the updated information from theCTI service.

There is no graphical display available for these statistics.

Thedisplay fields are described in the following table.

Field Description

Contact Service Queue The name of the CSQ.

Agents Logged In The number of agents currently logged into the system.

Agents in Talking The number of agents currently in the Talking state.

Agents Ready The number of agents currently in the Ready state.

Agents Not Ready The number of agents currently in the Not Ready state.

Agents in Work The number of agents currently in the Work state.

Agents Reserved The number of agents currently in the Reserved state.

Current Oldest The number of calls in queue and the elapsed wait time of the oldest
call in the queue, displayed in the format “x [hh:mm:ss]”, where X is
the number of calls and hh:mm:ss is the elapsed wait time.

Total Calls Total number of calls that have arrived, including calls waiting, calls
connected to agents, and calls that have disconnected.

Handled Calls Today Number of calls handled by the CSQ for the current reporting period. A
handled call is defined as an inbound call (ACD and non-ACD) presen-
ted to and answered by the agent.

Calls Abandoned Number of calls that were routed to the CSQ but were not answered by
an agent because the caller hung up or was disconnected.
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Field Description

Calls De-queued Number of calls that were dequeued. A call is considered to be
dequeued from a particular CSQ if the call is handled by an agent in
another CSQ. This situation can occur when a call is queued for more
than one CSQ.

Start Time The starting date and time of the current reporting period.

End Time The ending date and time of the current reporting period.

Talk Average Average talk time for all calls handled by agents. Talk time is the
elapsed time between the time that an agent connects to a call and
when the call is disconnected or transferred, not including hold time.

Average Wait Duration Average wait time for calls routed to the CSQ. Wait time is the elapsed
time between the time a call entered the queue and the time the call
was answered by an agent or was disconnected.

Longest Talking Longest talk time of any one call that agents have handled. Talk time is
the elapsed time between the time that an agent connects to a call
and when the call is disconnected or transferred, not including hold
time.

Longest Waiting Longest wait time for any one call routed to the CSQ. Wait time is the
time that elapsed between the time a call entered the queue and the
time the call was answered by an agent or was disconnected.

Calls Priority 1 … Calls Pri-
ority 10

Total number of Priority N calls that were routed to each CSQ.

Voice CSQs - Team Summary
TheTeam Summary display is availablewhen you select theSkill Groups node in theSkill
Groups tree.

This display presents thedetails of each individual skill group, regardless of whether or not
an agent with that skill is logged in. By default, the data displayed is sorted in ascending
order by skill name.

Thedata is obtained from theCTI server unless otherwise noted, and are for the current
day starting at midnight. Thedata refresh rate is configurable and ranges from every 5 to
60 seconds. By default it is every 15 seconds.

Note: Even though you can configure the refresh rate, it is still dependent on how
often the Enterprise service queries theCTI service (every 10 seconds). If the

44



Real TimeDisplays

refresh rate is changed to a shorter time interval, the display will be refreshed at
that interval, but the statisticsmight not changeuntil the Enterprise service
receives the updated information from theCTI service.

Graphical displays of this information consist of bar chartswith the skill nameon theY axis
and any of the available statistics listed in the table below on theX axis, expressed in either
an integer (0, 1, 2…) or timeduration (hh:mm:ss).

Thedisplay fields are described in the following table.

Field Description

Contact Service Queue The name of the CSQ.

Agents Logged In The number of agents currently logged into the system.

Agents in Talking The number of agents currently in the Talking state.

Agents Ready The number of agents currently in the Ready state.

Agents Not Ready The number of agents currently in the Not Ready state.

Agents in Work The number of agents currently in the Work state.

Agents Reserved The number of agents currently in the Reserved state.

Current Oldest The number of calls in queue and the elapsed wait time of the oldest
call in the queue, displayed in the format “x [hh:mm:ss]”, where X is
the number of calls and hh:mm:ss is the elapsed wait time.

Total Calls Total number of calls that have arrived, including calls waiting, calls
connected to agents, and calls that have disconnected.

Handled Calls Today Number of calls handled by the CSQ for the current reporting period. A
handled call is defined as an inbound call (ACD and non-ACD) presen-
ted to and answered by the agent.

Calls Abandoned Number of calls that were routed to the CSQ but were not answered by
an agent because the caller hung up or was disconnected.

Calls De-queued Number of calls that were dequeued. A call is considered to be
dequeued from a particular CSQ if the call is handled by an agent in
another CSQ. This situation can occur when a call is queued for more
than one CSQ.

Start Time Starting date and time of the current reporting period. If there is a fail-
over, the start time reflects the time when the failover occurred.
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Field Description

End Time The ending date and time of the current reporting period.

Talk Average Average talk time for all calls handled by agents. Talk time is the
elapsed time between the time that an agent connects to a call and
when the call is disconnected or transferred, not including hold time.

Average Wait Duration Average wait time for calls routed to the CSQ. Wait time is the elapsed
time between the time a call entered the queue and the time the call
was answered by an agent or was disconnected.

Longest Talking Longest talk time of any one call that agents have handled. Talk time is
the elapsed time between the time that an agent connects to a call
and when the call is disconnected or transferred, not including hold
time.

Longest Waiting Longest wait time for any one call routed to the CSQ. Wait time is the
time that elapsed between the time a call entered the queue and the
time the call was answered by an agent or was disconnected.

Calls Priority 1 … Calls Pri-
ority 10

Total number of Priority N calls that were routed to each CSQ.
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Agent E-Mail Viewer
You can view customer e-mailmessages, along with agent responses and attachments, in
theAgent E-Mail Viewer.

You can view any e-mail listed in theAssigned,Queued, or Resolved real timedisplays or
under the E-Mail node in theAgents tree. Formoredetails on E-Mail CSQ real time
displays, seeReal TimeDisplays.

The fields displayed in theAgent E-Mail Viewer are listed in the following table.

Field Description

From The sender of the e-mail.

To The recipient of the e-mail.

Cc The external e-mail addresses of the recipients copied in on the e-
mail, if any.

Subject The subject of the e-mail.

Sent The date and time when the customer sent the e-mail.

Received The date and time when the e-mail was received.

Handled By The name of the agent who handled the e-mail.

Handled Date The date and time when the agent replied to the customer.

To vew an e-mail using theAgent E-Mail Viewer:

1. Double-click an e-mail from theAssigned,Queued, or Resolved real timedisplay or
under the E-Mail node in theAgents tree. Thee-mail opens in theAgent E-Mail Viewer.

2. Double-click any inbound or outbound attachment. The attachment opens in an
application based on the attachment’s format.

Note: Although you can edit opened attachments, those changes are not
saved andwill not appear in the e-mail attachment when reopened.
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Supervisor Record Viewer
TheSupervisor Record Viewer displays all recordingsmadeby your team over the last
seven days aswell as those you tag for a 30-day extended lifetime.

Note: Supervisor Record Viewer is a separate program from Supervisor Desktop.
Closing Supervisor Desktop will not closeSupervisor Record Viewer.

TheSupervisor Record Viewer displays the information listed in the following table.

Field Description

Agent The name of the agent whose call is recorded.

Team The team to which the agent belongs.

Time The time the recording was made.

Duration The length of the recording in hh:mm:ss format.
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Field Description

Lifetime The length of time the recording is archived. Normal is 7 days, Exten-
ded is 30 days.

Date Recorded Appears only when “Extended Lifetime” is selected in Day Select. The
date the recording was made.

Note: A license is used whenever a playback is in progress and released when the
playback ends. If no licenses are availablewhen you attempt to play back a
recording, this errormessage is displayed: “A licensing error has occurred. Please
try again in fiveminutes. If the problem persists, please see your log file or System
Administrator for details.” Youmust wait until a license is released and available in
order to review any recordings.

Note: In a HighAvailability system, recordings can be stored on either of the two
recording servers, and all are displayed in Supervisor Record Viewer. If oneof the
servers becomes inactive and cannot be accessed, the recordings stored on that
server cannot beplayed, even though they continue to bedisplayed in Supervisor
Record Viewer. If you attempt to play a recording stored on an inactive server,
youwill see the errormessage, “The recording server is inactive.” Youwill be able
to play the recording when the server becomes active again.

The recordings are archived as raw voicedata packets; they can only beplayed back
using theSupervisor Record Viewer. However, if youwant to save selected recordings as
WAV files, you can use the “Play and Save” button and save the recording to a folder in
WAV format.

Unless recordings are tagged for an extended lifetime, they are automatically deleted after
seven days.

If a recording is tagged for the 30-day extended lifetime, it will not bedeleted until that
30-day period expires. If you delete it manually before the 30-day period expires, it is
deleted in the next folder cleanup. Cleanups run daily at midnight.

To start Supervisor Record Viewer:
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1. From theSupervisor Desktopmenu bar, chooseTools > Recorded Files. Supervisor
Record Viewer startswith the current day selected.

2. From theDay Select section, click oneof the date options to view the recordingsmade
by your team on that date.

To listen to a recording:

1. From theDay Select section, click the option for the date of the recording youwant to
review.

You can also click the Extended Lifetimeoption to view a list of all recordings that have
been tagged for extended 30-day archiving.

2. Select the recording youwant to review.

3. Click theplay button, or chooseRecording > Play from themenu bar.

Use thePauseor Stop buttons to control the recording playback, and the volume
slider to control the playback volume.

There is a progress bar at the bottom of thewindow that showswhere you arewithin
the recording. You can click theprogress bar and drag it to the left or right to rewind or
fast forward the recording. To restart the playback, click Play.

Note: You cannot play back a recording while you aremonitoring a call.

To save a recording:

1. Select the recording youwant to save.

2. Click thePlay and Savebutton, or chooseRecording > Play and Save from themenu
bar. TheSaveAsdialog box appears.

3. Select the folder where the recording is to be saved, enter a file name for the record-
ing, and then click Save. The recording plays and simultaneously is saved as aWAV file
to the location you selected.

To tag a recording for extended archiving:

1. Select the recording youwant to archive for 30 days.
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2. Click theSet Extended Lifetimebutton, or choose File > Set Extended Lifetime from
themenu bar. The recording is tagged to be archived for 30 days from thedate of
recording.

Toolbar and Shortcut Keys

From left to right, the toolbar buttons are:

n Play

n Play & Save

n Pause

n Stop

n Set Extended Lifetime

n Set Normal Lifetime

n Delete

n VolumeControl

The shortcut keys for Supervisor Record Viewer are listed in the following table.

Shortcut Key Description

Ctrl+D Selects the first option in the Day Select section. Use the left and right
arrows to navigate within the section.

Ctrl+F Selects the first recording in the list if no other recordings are selected.

Ctrl+S Plays the selected recording and simultaneously saves it as a WAV file
to the selected location.
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Supervisor Work Flow Administrator
SupervisorWork Flow Administrator enables you to configure your desktop to perform
certain actions based on queue statistics for callswaiting and calls in queue for specified
skill groups.

Thesework flows apply only to you, not to any other supervisors, and are available to you
no matter where you log into Supervisor Desktop. They are tied to your login information.

In general, work flows consist of events, thresholds, and actions.

n Theevent that triggers an action is a queue statistics update.Queue statistics are
updated onceevery 5 seconds.

n The thresholds the event must meet is oneor both of the following:

n Thenumber of callswaiting is below,within, or above specified limits

n Theoldest call in queue is below,within, or above specified limits

n The actions triggered by meeting the thresholds can be:

n Change the color of the skill group name in the tree control and/or add a
messagenext to it

n Highlight data in the tabular real timedisplay

n Display a popupmessageon your desktop

n Play aWAV file on your desktop

n Send an e-mail to selected recipients

For example, you can set up awork flow so that when there aremore than 10 callswaiting
in thequeue for Skill Group 6500, the skill group name in theSkill Groups tree turns red
and an audiblewarning sounds every 15 seconds.

Note: Supervisor work flow actions are available at thePremium level, except for
the TreeControl action,which is also available at the Enhanced level.

Setting Up aWork Flow
Follow these steps to set up a supervisor work flow.

To set up a supervisor work flow:
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1. ChooseTools > SupervisorWork Flow Administrator.

2. In theSupervisorWork Flow List dialog box, click Add.

3. In theAdd NewWork Flow dialog box, enter a name for your newwork flow and click
OK.

4. In theSkill Group Selection dialog box, select the skill groups youwant yourwork flow
to apply to from theAvailable Skill Groupspane and use the arrows to move them to
theSelected Skill Groupspane, and click OK.

Note: A skill group can bepart of only onework flow per supervisor.

5. In theSupervisorWork Flow Setup dialog box, set up theparameters for thework
flow.

a. Specify the upper and lower limits for theCallWaiting and/or Current Oldest
threshold. Note that when you select bothCallsWaiting and Current Oldest, the
highest threshold crossed takesprecedence.

b. Select Above from theThresholds pane.

c. Click Add. In the resulting Action TypeSelection dialog box, select the action you
want to be triggered when theCallsWaiting and/or Current Oldest statistic is
above the upper limit you set, and then click OK. SeeWork Flow Actions for inform-
ation on the types of actions available.

d. Repeat stepsb–c for theWithin and Below thresholds.

6. When you have finished completing theSupervisorWork Flow Setup dialog box, click
OK to enable thework flow.
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Example of Setting Up a SupervisorWork Flow
The following is a step-by-step example of setting up a supervisor work flow. Thiswork
flow:

n Changes the skill group namecolor to green and displays “Below” next to it in the
Skill Groups tree controlwhen there are fewer than two callswaiting, or if the cur-
rent oldest call is less than 1 minute old.

n Changes the skill group namecolor to blue and displays “Caution” when there are
2 to 5 callswaiting, or if the current oldest call is between 1 and 5minutes old.

n Changes the skill group namecolor to red and displays “Warning” when there are
more than five callswaiting, or if the current oldest call ismore than 5 minutes old.
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To set up the example supervisor work flow:

1. ChooseTools > SupervisorWork Flow Administrator.

2. In theSupervisorWork Flow List dialog box, click Add.

3. In theAdd NewWork Flow dialog box, enter the name “CustomerManagement” and
then click OK.

4. In theSkill Group Selection dialog box, select the skill groups youwant yourwork flow
to apply to from theAvailable Skill Groupspane and use the arrows to move them to
theSelected Skill Gropuspane. Click OKwhen finished.

5. In theSupervisorWork Flow Setup dialog box, select theCallsWaiting check box and
set the lower limit to 2 and the upper limit to 5.

Select theCurrent Oldest check box and set the lower limit to 1 minute and the upper
limit to 5 minutes.
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6. Select Below in theThresholds pane and then click Add under theActions pane.

7. In theAction TypeSelection dialog box, select TreeControl Action and click OK.

8. In the TreeControl Action dialog box, select theDisplay Text check box and Below
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from thedrop-down list.

9. Select theChangeText Color check box, click Set Color, choosegreen from the color
palette displayed, and then click OK.

10. Repeat steps 6–9 for theAbove andWithin thresholds. For Above, select “Warning” as
thedisplay text and set the color to red. ForWithin, select “Caution” as thedisplay text
and set the color to blue.When you are finished, click OK to enable thework flow.

The skill group nameswill now becolor-codedwith text displayed.
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Work Flow Actions
There are fivework flow actions that can be triggered by threshold rules. These actions
are:

n AudibleAlert Action

n E-Mail Alert Action

n MessageBox Action

n Report Action

n TreeControl Action

Audible Alert Action

TheAudibleAlert action plays aWAV file on your desktop whenever the threshold rules are
met. By default, the file plays once, but you can also configure it so that it plays repeatedly
at specified intervals.

This action is available at thePremium level.

Note: You can turn off audible alerts that are configured to repeat at intervals by
choosing Actions > SupervisorWork Flow — Audio Off from themenu.

Your computermost likely has systemWAV files available that are used to signal standard
Windowsevents. These files are a good sourceof sounds.

Note: TheWAV file you select must be50 KB or smaller.

To set up an audible alert action:

1. Click Add New and browse to the location of your selectedWAV file.

2. If desired, set up a repeat interval.
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3. Click OK.

E-Mail Alert Action

TheE-mail Alert action enables you to send an e-mail to specified peoplewhenever the
threshold rules are not met.

The e-mailmessages havepredefined subject lines, depending onwhat threshold rule is
met. They are:

n Skill: <CSQname>,Number of CallsWaiting is above upper limit

n Skill: <CSQname>,Number of CallsWaiting is below lower limit

n Skill: <CSQname>,Number of CallsWaiting iswithin upper and lower limits

n Skill: <CSQname>,Oldest Call in Queue is above upper limit
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n Skill: <CSQname>,Oldest Call in Queue is below lower limit

n Skill: <CSQname>,Oldest Call in Queue iswithin upper and lower limits

Thee-mailmessages sent can consist of just theSubject line. Amessage in thebody of
the e-mail is optional.

To set up an e-mail alert action:

1. Complete the fields in the E-Mail Alert Action Setup dialog box as follows.

Field Description

From Required. Enter your e-mail address.

To Required. Enter the e-mail addresses of the recipients,
separated by a semicolon.

Mail Server Required. TheSMTP IP address or host nameof the e-
mail server used to send the e-mail.

BCC Optional. Enter the e-mail addresses of the recipients you
want copied in on the e-mailmessage.

2. Click Send to verify that the e-mail alert action is configured correctly. If the test e-
mail is successfully sent, “Mail Sent Successfully” appears in the field next to theSend
button. “Error sendingmail” appears if there is a problem. If this occurs, check your
entries in the To, BCC, andMail Server fields for accuracy and test the action again
until it is successful.
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3. Click OK.

MessageBoxAction

TheMessageBox action pop ups amessagebox containing a customizedmessageon
your desktop whenever the threshold rules aremet. Themessagebox is closed by clicking
OK.

This action is available at thePremium level.

To set up amessagebox action:

1. Type yourmessage in theMessageText field.

2. Select the appropriatemessage icon from thedrop-down list.
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3. Click OK.

Report Action

TheReport action highlights cells in the Team Skill Statistics real timedisplay when the
data in the cells exceeds the threshold rules. The cells appear in theCSQand Oldest in
Queue columns.

This action is available at thePremium level.

To set up a report action:

1. Click Set Color and select the color to use for highlighting the cells.

2. Select theShow Team Skill Statistics Report check box if youwant Supervisor
Desktop to automatically change its focus to display the Team Skill Statistics real time
display whenever a statistic changes and triggers theReport action.

3. Click OK.
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TreeControl Action

TheTreeControl action enables you to select a color to apply to a skill group nameand/or
amessage to display beside the name in theSkill Groups tree controlwhenever the
threshold rules aremet.

This action is available at the Enhanced and Premium levels.

To set up a tree control action:

1. Select theDisplay Text check box and text from thedrop-down list if youwant the
text to bedisplayed next to the skill group name.

2. Select theChangeText Color check box and click Set Color if youwant to choose the
color for the text and the skill group name.

3. Click OK.
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Supervising Agents

Monitoring an Agent
The voicemonitor button enables you to silently listen in on an agent’s phone
conversations.

Voicemonitoring is availablewhenever an agent is logged in to Agent Desktop (uses either
desktopmonitoring or servermonitoring) or IP PhoneAgent (uses servermonitoring only).
It is not availablewhen:

n You are a participant in a phone call (you cannot monitor yourself)

n You use theBarge-In or Intercept function

n In amulti-line situation, the agent is talking on the non-ACDsecond line

Note: The administrator can restrict you frommonitoring an agent’s non-ACD
phoneconversations.

TheVoiceMonitor Volumebutton allows you to control the volumewhenmonitoring an
agent’s phone conversation. The system remembers your last volumesetting and uses it
the next time you log in.

Whenmonitoring a call, keep inmind the following considerations:

n When you select a specific call from theTeam View pane to monitor, all voice activ-
ity to and from that particular agent ismonitored. Themonitoring is not limited to
the call you selected. For instance, if the agent puts the selected call on hold and
switches to another call, both callswill bemonitored.

n If notification is off, agents have no way of knowing if you aremonitoring their calls.

Monitoring sessions are on a per agent basis, and only onemonitoring session can be in
progress at one time.When you select an agent from theTeam View pane to monitor, you
can hear all voice activity to and from that agent. If configured by your administrator, the
monitoring session is not limited to one call. For instance, if the agent puts an active call on
hold and switches to another call, youwillmonitor both calls.

You can record whilemonitoring an agent.

To start monitoring an agent:
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1. Choose an agent in theAgents tree.

2. Click theStart VoiceMonitor button, or choose Intervention > Start VoiceMonitor.

To stopmonitoring an agent:

n Click theStop VoiceMonitor button, or choose Intervention > Stop VoiceMonitor.

Pushing aWeb Page to an Agent
You can coach an agent by pushing aweb page to that agent’sAgent Desktop integrated
browser.

To push aweb page to an agent:

1. From theAgents tree, select an agent.

2. Choose Intervention > Coach by Pushing a Page. ThePushURL to Agents dialog box
appears.

3. Enter theURL of theweb page youwant the agent to see, and then click Push to send
theweb page to the agent. Theweb page you pushed to the agent is displayed in the
first tab of the agent’s integrated browser. This tab is reserved for pushedweb pages.

Note: There are no restrictions onwhat you can enter as a URL (for example,
you are not required to prefix theURLwith “http://”) as long as theURL can
be resolved by a browser. Somesites require that “http” or “https” bepart of
theURL.

Note: If the integrated browser is not enabled for the selected agent, this
operationwill fail and no errormessagewill appear.
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Barging in on a Call
TheBarge-In feature enables you to join an agent’sACD (and if enabled by the
administrator, non-ACD) phone conversation.When you click theBarge-In button, you
are automatically added to thephone call. It is a forced conference.

Note: To barge in on a call, youmust first be logged into Agent Desktop.

If notification is enabled, the agent sees amessage that you are attempting to join the call,
then sees amessage that you have successfully joined it.

When you use theBarge-In feature, voicemonitoring is disabled. You can, however,
record calls.

You cannot barge in if any of the following conditions are true:

n The agent is on hold

n The agent is on two calls

n The agent is in a conference call

n You are already on another call

To barge in on a call:

1. Select an agent call in the team view pane.

2. Click Barge-In or choose Intervention > Barge-In. You are added to the call.

At any timeduring the conference call, you can click Intercept to disconnect the agent
whose call is selected from the conference call and continue talking with the remaining
parties yourself.

To drop thebarged-in call:

n In Agent Desktop, select the conference call in the contact appearancepane and
then click Drop.

Intercepting a Call
The Intercept feature enables you to intercept an agent’sACD (and if enabled by the
administrator, non-ACD) phone conversationwhile disconnecting the agent from that
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phone call. It is a forced transfer.

Note: To intercept a call, youmust first be logged into Agent Desktop.

Note: You can intercept a call only once. For example, if you intercept a call, drop
out of the conversation, and then attempt to intercept the samecall again, youwill
not be able to do so.

If notification is enabled, the agent sees amessage that you are attempting to intercept
the phone call, then sees a furthermessagewhen the interception is successful.

When you use the Intercept feature, voicemonitoring is disabled. You can, however,
record calls.

You cannot intercept if any of the following conditions are true:

n The agent is on hold

n The agent is on two calls

n You are already on another call

To intercept a phone call:

1. Select an agent call in the team view pane.

2. Click Intercept or choose Intervention > Intercept. The call is transferred to you.

If you are intercepting a conference call you are on, the agent call you selected in the
team view pane is dropped from the conference call, and all other participants in the
conference call remain connected.

To drop the intercepted call:

n In Agent Desktop, select the intercepted call in the contact appearancepane and
then click Drop.

Recording a Call
You can useSupervisor Desktop to record, save, and play back ACD calls handled by
agents on your team. If enabled by the administrator, you can also record an agent’s non-
ACDphonecall.
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Recordings aremadeon a per call basis, andmultiple recordings can be in progress at the
same time. Recordings can bemadeon all lines for an agent, including non-ACD lines (if
enabled by your administrator). For instance, if an agent puts an active call on hold and
starts another call, you can record both calls, if the administrator configuration allows it.

You use theSupervisor Record Viewer to review recorded calls.

You can use theBarge-in, Intercept, and VoiceMonitor featureswhile recording.

When recording a call, keep inmind the following considerations:

n The recording feature is not intended to record every call. It is an on-demand solu-
tion only.

n When you select a call from theTeam View pane to record, only the voice activity
for that particular call is recorded. The recording is limited to the call you selected.
In order to record all voice activity from an agent across all lines, each callmust be
individually selected for recording. For instance, if the agent puts the selected call
on hold and switches to another call, youmust select the other call and press
Record in order to record both calls.

n Your administratormust enable recording of non-ACDcalls.

n The recording will end when the selected call terminates, or when youmanually
stop recording,whichever comes first.

n Agents can be configured so that they can start and stop recording calls. However,
an agent cannot stop a recording started by a supervisor. If an agent attempts to
do so, their Agent Desktop or IP PhoneAgent interface indicates the recording is
stopped. However, the recording is not stopped, and Supervisor Desktop displays
an icon indicating that recording is proceeding.

n You can stop a recording initiated by an agent.

n If notification is off, agents have no way of knowing if you are recording their calls.
If an agent attempts to start recording a call that you are already recording, the
agent will see a recording icon on the call, although the agent is not in control of the
recording.

n When you or an agent record a call, a recording license is used. The license is
released when the recording stops. If all recording licenses are in usewhen you
attempt to start a recording, the recording will not start.
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Note: When you receive amessage saying the recording has failed due to the
server running out of disk space, you free the space for new recordingsby
deleting the existing recordings in theSupervisor Record Viewer.

To record a call:

1. Choose the call youwant to record from theAgents tree.

2. Click theStart Record button, or choose Intervention > Call/Agent Start Recording.

3. When you are finished, click theStop Record button, or choose Intervention >
Call/Agent Stop Recording. The call is archived to theRecording service database,
where it is automatically saved for seven days.

Note: If youwant to save the recording for a longer period, you can do so for
up to 30 days, after which it is deleted. Formore information on playing and
saving recordings, seeSupervisor Record Viewer.

Changing an Agent’s ACD State
You can useSupervisor Desktop to change theACDstate of an agent on your team,
including logging an agent out.

Note: If you log a CADagent out, that agent will continue to appear in the agents
tree and will be able to chat and receive teammessages. If you log out an IPPA
agent, that agent disappears from the agents tree.

To change an agent’s agent state:

1. From theAgents tree, select the agent whose state youwant to change.

2. On the toolbar, click the appropriate agent state button.

Note: There is a delay of about 2 to 3 secondsbefore the command to change agent
state takes effect. To ensure you set the desired agent state, allow enough time
between clicking Agent State buttons for the command to take effect.

Note: If an agent state change fails, youwill not see any failuremessage. Youwill know
that an agent state change succeeds if the icon next to the agent’s name in the team
view pane changes to the current agent state icon.
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Monitoring Agent-Deleted E-Mail
Agents are able to delete e-mail that is delivered to their inbox. Some reasons for deleting
an e-mail are:

n Thee-mail is spam

n Thee-mail is abusive

Thedeleted e-mail is not actually deleted. It is transferred to an e-mail address set up by
the administrator in Cisco Desktop Administrator.

You can view a deleted e-mail either of two ways:

n In theAgent E-Mail Viewer from its listing in the E-Mail CSQ- Resolved real time
display

n Using a third party e-mail client (for example,Microsoft Outlook)

TheAgent E-Mail Viewer only allows you to view the agent-deleted e-mail. If youwant to
permanently delete the e-mail, or re-queue it to be handled by another agent, youmust
use a third party e-mail client.

Consult with your administrator for the procedure for accessing agent-deleted e-mail.

Reviewing Agent E-Mail
TheE-Mail Review CSQ is used to review agents’ responses to customer e-mail. By
incorporating a Review CSQ into the e-mail handling process, a contact center can ensure
that any response undergoes a review before delivering it to the customer. If an agent’s
work flow group and e-mail CSQare configured for review, then all of the agent’s
responses are transferred to the E-Mail Review CSQ.

Youmust useAgent Desktop to participate in the review process. See theCisco Agent
Desktop User Guide formore information about reviewing e-mails.

Sending a TeamMessage
You can send a teammessage to all agents on a team,whether or not the agent is logged
into theACD.As long asAgent Desktop is open, an agent can view a teammessage.

Note: You cannot send teammessages to IP Phone agents.
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TheTeamMessagesdialog box stores the last 10 teammessages you broadcast. You can
select any oneof thesemessages to broadcast again. If you sendmore than 10 team
messages, the oldest onedrops off the stored list. You cannot designate any particular
teammessage for permanent storage.

Note: By default, the teammessage scrolls acrossAgent Desktop’s team
messagepane. Individual agents can set their preference in Agent Desktop to
view teammessages as stationary. A stationary teammessage ismore
compatiblewith screen readers,which are often used by vision-impaired agents.

TheCurrent Messagepanedisplays themessage that is currently being sent to your team.

To send a teammessage to all agents on a team:

1. From the team selection list, choose the team to which youwant to send themessage,
and then click View > TeamMessagesor click the TeamMessagesbutton.

2. Type yourmessage in the text box. The teammessagecan beup to 255 characters
long. Youmust type amessagebefore choosing an expiration time.

3. In the Expires at field, choose a specific time for themessage to expire. By default, the
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message runs for 30 minutes.

If you set a timeearlier than the current time, themessagewill run until that time the
next day. For example, if it is 10:15 AM and you set the expiration time to be10:00
AM, themessagewill run until 10:00 AM tomorrow.

4. Click Start or press Enter.

The teammessage is sent to the team for the length of time you chose. The text of the
message you sent is logged in the current team performancemessage field.

To cancel a teammessage:

n In the TeamMessagedialog box, click Stop.
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Chat
Chat enables you to send instant messages to agents and supervisors on your teams. In
addition, if your configuration includesCisco Unified Presence, you can send instant
messages to non-agents (called subject matter experts, or SMEs) who are using Cisco
Unified Personal Communicator.

SomeChat features include:

n You can send the samechat message to multiple recipients. The sending chat win-
dow closes after themessage is sent, and recipient’s replies, if any, appear in sep-
arate chat windows, one for each person.

n You can participate inmultiple concurrent chat sessions.

n The title bar of theChat window displays the nameof thepersonwithwhom you
are chatting.

n If you flag a chat message as high priority, theChat windowwill pop up on the
other person’s screen so that themessage is noticed immediately.

n If the priority of a chat message is normal (the default), theChat windowwill remain
in its current state (open orminimized) and the corresponding iconwill flash on
yourWindows task bar.

n A log of the chat messages sent between you and your chat partner (chat history)
is available as long as theChat window is open. After you close theChat window,
the log is lost.

n Chat history is in chronological order,with the oldest messages at the top of the
log pane.

n You can chat with agentswho are logged out of theACDas long as they still have
Agent Desktop open.

n You can chat with subject matter experts (SMEs) (non-agents).

n An agent’sACDstate is indicated by both an icon to the left of the agent nameand
by text to the right of the agent name.

n If you are logged into Unified Presence, an SME’sUnified Presence status is
indicated both by an icon to the left of theSMEnameand by text to the right of the
SMEname.
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Chat Contacts
Your contacts are organized in groupings called drawers in theChat Selectionwindow.
Somedrawers, such as theTeammates, Supervisors, and Conferencedrawers, are
default drawers. Any other drawers that appear are customized by your administrator and
appear only if you are logged into Unified Presence.

Theexample of a Contact Selectionwindow below shows thedefault Teammates and
Supervisors drawers, aswell as two customizable drawers, TAC and Engineering.

n TheAgents drawer lists all the agents on the team selected in Supervisor Desktop.
The agents’ agent state is indicated both by an icon to the left of the agent name
and by text to the right of the agent name. The agent state is updated whenever it
changes. Agents do not have to be currently logged into Agent Desktop to be
listed here, but they must haveAgent Desktop open and they must have logged in
at least once.

Note: You cannot chat with IP Phone agents.

n TheSupervisors drawer lists all supervisors on your team. Their status is always
listed asAvailable. Supervisorsmust be logged in to be listed here.

n TheConferencedrawer appearswhen you are on a conference call with other
agents. SMEs, if they are on the conference call, are not listed here.
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n ThePersonal Contacts drawer appears if you have this drawer set up in Unified Per-
sonal Communicator. The contacts in this drawer are administered in Unified Per-
sonal Communicator.

n Other drawers list theSMEs associated with thework flow groups to which your
agents belong. TheSMEs’ Unified Presence status is indicated both by an icon to
the left of theSMEnameand by text to the right of theSMEname. TheUnified
Presence status is updated whenever an SME status changes.

TheChat Selectionwindow also providesmenu access to the following call handling
functions:

n Making a call

n Transferring a call

n Initiating a conference call

Chat Shortcut Keys
The following table lists the shortcut keys in theChat window.

Shortcut Key Description

Alt+L Starts a chat session with the person highlighted in the Chat Selection
window. If you are already chatting with the highlighted person, Alt+L
will bring that chat window to the foreground.

Alt+C Opens the dial pad so you can call the person highlighted in the Chat
Selection window. The Name: Number field is auto-populated with the
selected person's extension.

Ctrl+Shift+H Selects the chat log pane.

Sending a Chat Message

To send a chat message:

1. Click Chat on the toolbar to open theChat Selectionwindow.

2. To chat with oneperson, double-click that person’s name. To chat with several
people, Ctrl+click to select their names and press Enter or chooseActions > Chat. A
Chat window opens and a session beginswith thepeople you selected.
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3. Type yourmessage in the text entry pane and click Send or press Enter. Yourmessage
is sent to your chat partner and logged in the chat history pane.

Replies from recipients of a groupmessage appear in individual chat sessionwindows.
They cannot reply to thegroup, they can reply only to you.

Note: If youwant yourmessage to benoticed immediately by popping on
your chat partner’s desktop, select theHigh priority check box.

Note: If you log out during a chat, your copy of the chat log is lost, the current
Chat window closes, and a newChat window opens so you can continue
communicating. Theentire chat log is still present in the other party’sChat
window.

To end a chat session:

n Choose File > Closeor click Close in the upper right corner of theChat window.

Predefined High Priority Chat Messages
Agents can have a task button in Agent Desktop configured to send a predefined high-
priority chat message to their supervisors. This predefinedmessage (for example, “Please
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barge in onmy call”) is set up by the administrator. It behaves just like a regular chat
message that is flagged as high priority—it pops up on your screen on top of all other
windows for your immediate attention.

You can reply to a predefined high-priority chat message from aCADagent.

Calling Someone in the Chat List
You canmake a call, transfer a call, or conference a call to anyone listed in your Chat
Selectionwindow using the call control actions.

n To call someone, youmust be logged into Agent Desktop and be in an agent state
that allows you to make a call.

n You cannot call someone listed in your Personal Contacts drawer.

n You do not have to be chatting with an agent or SME in order to call them.

The call controlmenu itemsare typically disabled for SMEs. In order to make a call,
transfer a call, or conference a call to an SME in your chat list, theSMEmust be configured
as an External Contact by your administrator. If an SMEnamedoes not have a phone
number associated with it, the call controlmenu itemsare disabled.

To call someone in your chat list:

1. In theChat Selectionwindow, do oneof the following:

n If you are chatting with theperson youwant to call, chooseActions > Call,
Transfer, or Conference.

n If you are not chatting with theperson youwant to call, select the person’s
nameand chooseActions > Call, Transfer, or Conference. You can also right-
click theperson’s nameand choose thedesired call action from the resulting
popupmenu.

Thedial pad appearswith theperson’s phonenumber autofilled in theName:Number
field.

2. Click Dial.
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Cisco Unified CCXWeb Chat
Unified CCXWeb Chat is a web-based application that allows agents to chat with
customers, and supervisors to view agent and team chat reports. It is configured for use
with CAD in theCisco Unified CCX Administration application by the administrator, and is
available only at thePremium feature level.

If configured for usewith CAD,Unified CCX Web Chat appears in the first tab of theAgent
Desktop integrated browser, and in the first tab after the real timedisplays in the
Supervisor Desktop integrated browser.

Supervisors have the option of enabling or disabling Unified CCX Web Chat’s appearance
in theSupervisor Desktop integrated browser. SeePreferences formore information.

For information on how to useUnified CCX Web Chat, see theCisco Unified CCX Web
Chat Agent and Supervisor Desktop User Guide, available at:

http://www.cisco.com/en/us/support/customer-collaboration/unified-contact-center-
express/products-user-guide-list.html

Unified CCXWeb Chat Reports
Once you log into Unified CCX Web Chat, you have access to reports on the chat activity
of your agents and teams. These reports are:

n Agent Summary Report

n CSQDetail Report

n CSQSummary Report
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Service Autorecovery
The service autorecovery feature allowsSupervisor Desktop to automatically recover its
connection to theCisco services in the event of a service restart or a network outage.

WhenSupervisor Desktop detects that it is unable to communicatewith a service
(generally within threeminutes of the service failure), the status bar displays “Partial
Service” or “No Service” to indicate someor all of the services have failed.

WhenSupervisor Desktop detects that the service is again available (usually within one
minute of service recovery), the status bar displays “In Service” to indicate that the
services have recovered.

Note: In somesituations, youwill not recover your connection to Cisco Unified
Presence and youmust log back into Unified Presencemanually.

To learnmore about what is affected by the service failure, double-click the status
messageon the status bar. Supervisor Desktop displays a popupwindow that lists
features and indicates if that feature is available or not due to the service outage.

Phone Network Failure
In the event that an agent’s phone loses its connection to the network, the agent is
automatically moved to theNot Ready agent state, and will see a popupwindow
displaying amessage that the phone is out of service.
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The supervisor will see the changeof agent state in theAgent ACDState Log report, along
with the “Device out of service” reason code (code32759).

The agent must drop any call he or she is on in order for the phone to reconnect to the
network. If the agent continues on a call, CADwill not be able to show the call’s actual
length because it showsas “terminated” in the system.

When thephone comesback into service, the agent will see thepopupwindow display a
message that the phone is in service. The agent can then change the agent state back to
Ready and resume taking calls.
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